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1. WPROWADZENIE 
W ćwiczeniu zostanie zaprezentowany sposób modelowania nieustalonej wymiany 

ciepła w przegrodzie cylindrycznej. Zostanie przeprowadzona symulacja 

jednowymiarowego przewodzenia ciepła w rurze wykonanej ze stali. Dodatkowym 

założeniem będzie liniowa zależność współczynnika przewodzenia materiału rury od 

temperatury. Schemat analizowanego przypadku przedstawiony jest na rys. 1.  

 

Rys. 1. Schemat zagadnienia nieustalonego przewodzenia ciepła w przegrodzie 

cylindrycznej  

 

 

 

2. JEDNOWYMIAROWE NIEUSTALONE PRZEWODZENIE PRZEZ PRZEGRODĘ 

CYLINDRYCZNĄ 
Wykonaj następujące zadania: 

Ściana 

wewnętrzna 

T1 = 100°C 

Ściana 

zewnętrzna 

T2 = 20°C 

Powierzchnie 

symetrii 



1) Otwórz program Ansys Workbench i zapisz projekt o nazwie Cw1 w katalogu 

o nazwie Cw1 (File->Save As).  

ZASADA PRAKTYCZNA NR 1: Dla każdego projektu tworzymy osobny 

katalog 

ZASADA PRAKTYCZNA NR 2: W nazwach katalogów nie stosujemy: spacji, 

znaków specjalnych (np. @#$%^&* itp.) oraz polskich znaków 

 



 
2) Wybierz moduł Mesh i otwórz program Spaceclaim. W tym celu chwyć lewym 

przyciskiem myszy (LPM) moduł Mesh i przeciągnij go do pola Project 

Schematic. Następnie kliknij dwukrotnie LPM na Geometry w celu 

uruchomienia programu Spaceclaim, w którym zostanie utworzona geometria. 

Zwróć uwagę, że w lewym dolnym rogu ekranu pojawia się napis informujący 

jaki program jest uruchamiany. 



 



 
3) W programie Spaceclaim utwórz rurę cylindryczną o wymiarach 

przedstawionych na rys. 2. Długość rury ustal na 100 mm. 



 

Rys. 2. Wymiary rury cylindrycznej w przekroju (długość rury wynosi 100 mm) 

 

W tym celu kliknij LPM ikonę Select New Sketch w celu wybrania 

płaszczyzny rysowania. 

 
Wybierz płaszczyznę X-Y jak na rysunku poniżej. 



 
 

Kliknij ikonę Plan View w celu obrócenia płaszczyzny rysowania 

równolegle do ekranu (możesz też to zrobić wciskając Shift + v). 

 
 

W panelu u góry ekranu wybierz ikonę rysowania okręgu  i zbliż kursor do 

środka ukłdu współrzędnych po czym naciśnij klawisz Shift – pojawią się dwa 

pola do edycji wymiarów jak pokazano poniżej. 

 



Pomiędzy polami edycji wymiaru można się przełączać klawiszem Tab. Ustaw 

wymiar poziomy na 0 natomiast pionowy na 25 mm i naciśnij klawisz Enter. 

 
Program przejdzie do rysowania okręgu. Wpisz wartość 16 mm i zatwierdź 

klawiszem Enter. Pamiętaj, że w razie niepowodzenia w każdym momencie 

możesz kliknąć ikonę cofnięcia  (znajduje się w lewym górnym rogu 

ekranu) lub Ctrl + z.  

 
Następnie utwórz drugi okrąg o średnicy 10 mm przez kliknięcie LPM w środek 

poprzednio utworzonego okręgu. 



 
W celu wyjścia z polecenia rysowania okręgu naciśnij klawisz Esc i LPM 

kliknij ikonę przejścia do rysowania 3D 

 
Obróć widok za pomocą przytrzymania przycisku myszy Scroll i jego 

przesunięcia tak, aby uzyskać widok izometryczny podobny do tego poniżej. 



 
Wybierz polecenia Pull 

 
Następnie ustaw kursor tak jak pokazano na rysunku poniżej 



 
Przesuwając kursor przy wciśniętym LPM zauważysz zmieniający się wymiar 

długości rury. Wpisz 100 mm i zatwierdź Enter (możliwe, że będziesz musiał to 

zrobić przy wciśniętym LPM). 

 
Ostatnim krokiem jest usunięcie zbędnej płaszczyzny zasklepiającej otwór rury. 

W tym celu naciśnij Esc a następnie wybierz zbędną płaszczyznę (zrobi się 

wtedy pomarańczowa jak na rys. poniżej) i naciśnij klawisz Delete.  



 
4) Zamknij program Spaceclaim i zapisz projekt w Workbench za pomocą Ctrl + s 

5) W module wykonywania siatki numerycznej Mesh wykonaj siatkę numeryczną, 

tak aby wyglądała podobnie do tej przedstawionej na rys. 3. 

 

Rys. 3. Widok siatki numerycznej dla zagadnienia jednowymiarowego 

nieustalonego przewodzenia ciepła w rurze cylindrycznej 

W tym celu otwórz program Ansys Meshing przez dwukrotne kliknięcie LPM 

Mesh 



 
W programie Ansys Meshing: 1) kliknij Mesh, 2) Zmień pole Physisc 

Preference na CFD, 3) Zmień pole Solver Preference na CFX, 4) Kliknij LPM 

Generate Mesh 



 
Jak widać domyślna siatka nie  jest podobna do siatki z rys. 3. W celu jej 

naprawy należy najpierw edytować geometrię. Przetniemy rurę na pół w celu 

utworzenia krawędzi, na których następnie możliwe będzie nadanie liczby 

elementów siatki numerycznej. Zamknij moduł Ansys Meshing i otwórz 

program Spaceclaim. 

 

1 

2 

3 

4 



Wybierz ikonę tworzenia płaszczyzn  i LPM kliknij oś Y w celu utworzenia 

płaszczyzny YZ 

 
Wybierz ikonę Split i wskaż LPM przy wciśniętym klawiszu Ctrl 3 

powierzchnie zewnętrzne rury (oznaczone na niebiesko)  



 
Następnie wybierz polecenie Select Cutter Face  

 
A następnie wskaż utworzoną wcześniej płaszyznę YZ i zamknij program 

Spaceclaim i otwórz Ansys Meshing. 



 
Podczas otwierania Ansys Meshing pojawi się komunikat 

 
Wybierz Yes. 

W Ansys Meshing naciśnij prawy przycisk myszy (PPM) na Mesh i wybierz 

Insert->Sizing 

 



U góry ekranu wybierz filtr wybierania krawędzi Edge 

 
Wybierz długą krawędź (na rys. poniżej linia przerywana) i zatwierdź 

Geometry->Apply (jeśli nie widać Apply kliknij LPM w żółte pole). 

 
Zmień pole Definition->Type z Element Size na Number of Divisions. W polu 

Number of Divisions ustaw wartość 1 

 
Kliknij Generate Mesh i sprawdź wygenerowaną siatkę (jeśli nie widać siatki 

kliknij LPM na Mesh w drzewku po lewej stronie). 

Wykonaj podobne czynności dla krawędzi pokazanej na rys. poniżej z tą 

różnicą, że Number of Divisions = 6 



 
W Ansys Meshing naciśnij prawy przycisk myszy (PPM) na Mesh i wybierz 

Insert->Method 

LPM wybierz rurę (stanie się zielona) i zatwierdź Apply. 

 
Zmień Method z Automatic na Multizone i kliknij Generate Mesh  



 
Siatka numeryczna jest poprawna. 

 
Ostatni krok to nadanie nazw objętościom i powierzchniom. 

Wybierz LPM filtr wyboru brył 

 
Wybierz rurę LPM, a następnie kliknij PPM i wybierz Create Named Selection 



 
Jako nazwę proszę wybrać Solid_domain 



 
Następnie proszę zmienić filtr na wybór powierzchni 

 
LPM wskaż zewnętrzną powierzchnię rury i kliknij PPM, a następnie wybierz 

Create Named Selection (rura została wcześniej podzielona na pół więc teraz 

zenętrzna powierzchnia składa się także z dwóch części; przy wyborze 

powierzchni zewnętrznej wskaż obie półówki przy wciśniętym klawiszu Ctrl) 



 
Nadaj nazwę outer 



 
Podobnie utwórz nazwy inner i side odpowiednio dla wewnętrznej powierzchni 

rury i dwóch powierzchni bocznych (w przypadku powierzchni bocznych 

należy wybrać 4 części). 

Zamknij moduł Ansys Meshing i zapisz projekt w Workbench. 

6) W module CFX wykonaj obliczenia jednowymiarowego nieustalonego 

przewodzenia ciepła przez przegrodę cylindryczną. Na powierzchni 

wewnętrznej rury ustaw stałą temperaturę T1 = 100°C, natomiast na 

powierzchni zewnętrznej T2 = 20°C. Współczynnik przewodzenia ciepła należy 

zaimplementować jako zależny od temperatury wg następującego wzoru 

 

  ( )0 1 bT = +   (1) 

 

              Tab. 1. Parametry wykorzystywane w obliczeniach 

λ0 

W/(m K) 

b 

1/K 

t 

s 

dt 

s 

40 -0,001 2 0.05 

 

W tym celu do Project Schematic przeciągnij lewym przyciskiem myszy moduł 

CFX 



 
W celu połączenia modułu Mesh z CFX chwyć LPM Mesh (to niżej) i 

przeciągnij na Setup aż do pojawienia się pola Transfer A3, a następnie puść 

LPM – połączenie zostało utworzone 

 
Kliknij PPM na Mesh i wybierz Update 



 
 

Kliknij dwukrotnie Setup w celu uruchomienia programu Ansys CFX 



 
W pierwszym kroku utworzysz materiał stali o współczynniku przewodzenia 

ciepła zależnym liniowo od temperatury zgodnie z równaniem (1). W tym celu 

rozwiń Materials w drzewku i naciśnij PPM na materiale Steel, a następnie 

wybierz Duplicate, aby utworzyć kopię. 



 
Zmień nazwę Copy of Steel na SteelLinearThermCond 

 
Utwórz Expression o nazwie lambda0 



 
W polu Details wpisz zgodnie z poniższym rysunkiem i zatwierdź Apply. 

 
Utwórz kolejne wyrażenie o nazwie b 

 

 
Utwórz wyrażenie o nazwie lambda obliczające współczynnik przewodzenia 

ciepła w zależności od temperatury T 

 

 
Zamknij tworzenie wyrażeń 

 
Kliknij dwukrotnie LPM na SteelLinearThermCond w celu edycji materiału 



 
W zakładce Material Properties rozwiń Transport Properties i w polu Thermal 

Conductivity kliknij ikonę Expressions  a następnie kliknij PPM w polu 

Thermal Conductivity i wybierz Expressions->lambda. Zatwierdź OK. 



 
Otwórz Analysis Type przez dwukrotne kliknięcie LPM 

 
Zastosuj następujące ustawienia zgodnie z tab. 1. i zatwierdź OK. 



 
Kliknij dwukrotnie LPM Default Domain 

 
Zastosuj następujące ustawienia i zatwierdź OK. 



 
Utwórz warunek brzegowy o nazwie outer 

 
Zastosuj ustawienia jak poniżej 

 
 



 
Utwórz warunek brzegowy o nazwie inner 

 
Zastosuj ustawienia jak poniżej 

 
 

 
Utwórz warunek brzegowy sym 

 
Zastosuj ustawienia jak poniżej 

 



Otwórz pole Solver Control 

 
Zastosuj poniższe ustawienia i zatwierdź OK. 

 
Otwórz Output Control 



 
Zastosuj poniższe ustawieania i zatwierdź OK. 



 
 

 
Utwórz warunki początkowe przez kliknięcie LPM ikony Global Initialization 

(u góry ekranu, prawie na środku) 

 
Zastosuj ustawienia jak poniżej i  zatwierdź OK. 

 



Zamknij program Ansys CFX. 

Kliknij dwukrotnie pole Solution w celu uruchomienia programu Ansys CFX 

Solver Manager 

 
Zastosuj poniższe ustawienia i naciśnij Start Run. Program wykona obliczenia. 

Zaczekaj kilka chwil na komunikat o zakończeniu obliczeń. 



 
Po skończeniu obliczeń program  wyświetli komunikat: 



 
Zatwierdź OK i zamknij Ansys CFX Solver Manager. Zapisz projekt w 

Workbench. 

7) W raporcie należy przedstawić kontury rozkładów temperatury w przegrodzie 

cylindrycznej dla czasów: 0; 0,1; 0,2; 0,3; 0,4; 0,5; 1,0; 2,0 s. Ponadto należy 

porównać na jednym wykresie rozwiązanie numeryczne rozkładu temperatury 

w ściance dla czasu 2 s z rozwiązaniem analitycznym (2) 
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gdzie λ1 = λ(T1), r to dowolny promień rury, r1 promień wewnętrzny rury, qL 

liniowa gęstość strumienia ciepła dana wzorem (3) 
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gdzie λm to średnia wartość współczynnika przewodzenia ciepła materiału rury. 

 
 ( ) ( ) ( )1 2 1 2

1 1

2 2
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(4) 

 

Kliknij dwukrotnie LPM Results w celu uruchomienia programu Ansys CFD 

Post i obejrzenia wyników 



 
Z menu Location wybierz Plane 



 
Zastosuj poniższe ustawienia i zatwierdź Apply. 

 
LPM naciśnij oś X 



 
Odznacz widoczność utworzonej wcześniej płaszczyzny. 

 
Wybierz tworzenie konturów i zatwierdź OK. 

 
Zastosuj poniższe ustawienia i zatwierdź Apply. 



 
Wybierz ikonę Time Step Selector  

 
i zmieniając czas symulacji obserwuj zmiany temperatury w czasie 

 



 
1) Po zapisaniu zdjęć konturów dla czasów 0; 0,1; 0,2; 0,3; 0,4; 0,5; 1,0; 2,0 s.  

wyłącz widoczność konturów 

 
Utwórz linie za pomocą Location->Line 

 
Zastosuj następujące ustawienia i zatwierdź Apply. 



 

 
Wybierz ikonę tworzenia wykresu i zatwierdź OK. 

 
Zastosuj ustawienia jak na poniższych rysunkach 



 
 

 
 



 
Zatwierdź Apply. W celu zoabaczenia wykresu wybierz zakładkę Chart Viewer 

 
W celu porównania wyników numerycznych z analitycznymi wyeksportuj 

wyniki numeryczne do pliku csv.  



 
Nadaj nazwę num_res i zapisz. Lokalizacja pliku jest pokazana w górnej części 

okna dialogowego i jest inna na każdym komputerze. 



 
8) Obliczyć strumień ciepła przepływający przez rurę 

Utwórz tabelę 

 
Upewnij się, że załadowane są wyniki dla czasu t = 2 s (ikona Timestep 

Selector). Do komórki A1 wklej wyrażenie obliczające strumień ciepła na 

powierzchni zewnętrznej rury 

 

=areaInt(Wall Heat Flux)@outer 

 

i naciśnij Enter. Do komórki B1 wklej wyrażenie obliczające strumień ciepła na  

powierzchni wewnętrznej rury 

 

=areaInt(Wall Heat Flux)@inner 

 

 
 

 

Wyniki jakie należy umieścić w raporcie: 

I. kontury rozkładów temperatury w przegrodzie cylindrycznej dla czasów: 0; 0,1; 

0,2; 0,3; 0,4; 0,5; 1,0; 2,0 s.  

II. porównać na jednym wykresie rozwiązanie numeryczne rozkładu temperatury 

w ściance dla czasu t = 2 s z rozwiązaniem analitycznym (2) 

III. w tabeli przedstawić strumień ciepła obliczony numerycznie i analitycznie 



 

  

Zadania nieobowiązkowe: 

 

1) Zadanie dodatkowe: Utwórz animację pokazującą zmiany temperatury 

w przekroju rury (pomoc: 

http://fluid.itcmp.pwr.wroc.pl/~pblasiak/CFD/UsefulInformation/animationCF

X.jpg) 

2) Zadanie dodatkowe: Wykonaj obliczenia ze współczynnikiem b = 0,001 1/K 

i porównaj oba rozwiązania zestawiając obok siebie wyniki I)-III)  

 

http://fluid.itcmp.pwr.wroc.pl/~pblasiak/CFD/UsefulInformation/animationCFX.jpg
http://fluid.itcmp.pwr.wroc.pl/~pblasiak/CFD/UsefulInformation/animationCFX.jpg

